CHAPTER 6 — FLIGHT PLAN COMPLETION

You have a route put together. This chapter will guide you through the rest of the preflight process: route modification, weight and balance calculations and weather acquisition.

Editing Your Route

THE ROUTE LIST
The Route List gives you a visual outline of all your routes and fixes, as well as quick access to many valuable functions through the right click menus. Using the Route List you can select, modify and delete waypoints, procedures and routes, center on a route or fix, optimize altitudes, and access the Route Calculator.

To Open/Close the Route List:
• Select View/Route List.
  • Or Use the CTRL/L hot keys.
  • Or Add the Route List icon to one of the toolbars using View/Customize Toolbars/Modify and click on it.

Structure of the Route List
The route list will display multiple routes and individual legs of multi-leg routes. The route list is structured in a hierarchical tree format in keeping with Windows file conventions. A route with a Plus Sign (+) next to it indicates that the list of legs or waypoints for that route is collapsed. Clicking on the + sign or double clicking on the route name will expand the list. Clicking on a Minus Sign (—) collapses the list to make it easier to see the rest of the route list.

To more easily hide routes in the chart view by collapsing them in the route list, go to Tools/Options/Display and check the box at the bottom next to “Hide Routes that are ‘collapsed’ in the route list.”

Selecting Waypoints and Routes
You can select multiple waypoints or routes by holding down the CTRL key and left mouse clicking on the desired names. You can select a group of routes or fixes in a row by holding down the SHIFT key and left clicking on the first and last names in the line you wish to select.
**Chapter 6  Flight Plan Completion**

**Route List Right Click Menus**
You can accomplish a multitude of operations using the right mouse click menus within the Route List. There are four right click menus in the Route list, one for each of the following:

- **Route Name** — a route with only one departure and destination, i.e., a single leg.
- **Route Group** — a route with multiple legs.
- **Waypoint** — any fix within a route leg.
- Anywhere else in the Route List box.

For step by step instructions on how to use specific commands, please see the online Help file, or use the program Tooltips or context-sensitive Help.

**ROUTE PROPERTIES**
The Route Properties dialog box gives you information about your route, as well as the ability to do the following:

- Name the Route
- Lock/Unlock a Route
- Hide or Display the Route
- Set Cross-Track Alarms
- Set Waypoint Arrival Alarms

**To Open the Route Properties Dialog Box:**

- Double click on a route on the chart view.

  **Or**
  - Left click on a route in the Chart View or the Route List to highlight it.
  - Right click on the route to open the menu.
  - Select **Properties**.
Name the Route
FliteStar names new manual routes numerically, “Route 1”, “Route 2”, etc., and routes created with the Route Wizard using the departure and destination points, such as KMBX->PRTD. To rename a route:
• Select a route by clicking on it in the Chart view or Route List.
• Open Route Properties.
• Click on the Name field in the Route Properties box and type in the new name.
• Click OK to accept your change.

Lock/Unlock a Route
After you’ve spent time setting up a route, you may want to lock the route when you are done so it isn’t inadvertently altered later.
• Select a route by clicking on it in the Chart view or Route List.
• Open Route Properties.
• Select the Locked check box to lock the route.
• Click OK to accept your change.

Now the route cannot be changed by dragging or clicking in the Chart View. To go back and edit the route, open Route Properties and clear the Locked check box.

Display/Hide Route
When you’re working with more than one route, or comparing alternative routes between the same points, you may find the route lines in the Chart view interfere with each other, yet you don’t want to delete any of them. To hide a route line in the Chart view,
• Select a route by clicking on it in the Chart view or Route List.
• Open Route Properties.
• Remove the check from the Visible box.
• Click OK to accept your change.

The Route is still displayed and fully editable in the Route List, it’s just hidden in the Chart View. To view the route again, go back to Route Properties and check the Visible box.

You can use the route list to quickly hide routes in the Chart View. Go to Tools/Options/Display and check the box next to “Hide Routes that are “collapsed” in the route list.”

Display/Hide Route Labels
Route labels for waypoints and altitude change points on your route can be displayed from the Preferences section of the Chart Properties dialog. See Preferences in the online Help or in Chapter 3 for additional information on viewing chart symbols and labels.

Default Winds and Flight Rules
Use these options when you’re setting up a point and click route.
MODIFYING A ROUTE

While FliteStar provides you with the most efficient route available within the parameters you set, there are times you want to modify the route FliteStar creates. There are several ways to do this.

Inserting Waypoints

Using the Chart View Rubber-Band Feature to Insert a Fix:

- In the Chart View, left click on the route to highlight it.
- Click between two waypoints on the highlighted, unlocked route.
- Click and drag the route to another waypoint or location.
- Release the mouse button and a new waypoint will be inserted into your route list.

If you release the mouse button where there is no defined waypoint in the database, FliteStar will create a route waypoint at that location and insert it into the route list. On the other hand, if you release the left mouse button at a position where multiple waypoints are located (such as at an airport with a collocated VOR), a dialog will appear to prompt you for a selection.

Using the Route List to Find and Insert a Fix:

On the Route List, highlight the waypoint before which you want the new fix to go.

Right click and select Find/Insert Fix.

The Search dialog opens with the All Types tab in view. You can click another tab to narrow the search to a specific waypoint type.

- Type in the full name, identifier, or city associated with the item. You can use the standard “?” or “*” as wildcards for searching with partial names.
- Select Find to start searching the database.
- Select Stop Search if the item you are looking for appears in the window before the search is complete.

When FliteStar returns a list of matches, click on your selection to highlight it.

Select one of the following options:

- Locate: A flashing red arrow appears on the chart pointing to the waypoint.
- Append: The selected item is placed at the end of the active route.
- Insert: The selected item is inserted immediately prior to the waypoint highlighted in the Route
Adding Waypoints to the End of a Route

**Route List**
Follow the procedures described above in *Using the Route List to Find/Insert a Fix* and select the **Append** option in the Search dialog.

**Chart View**
- Click on the **Tools Menu** and choose **Add Route Waypoints**
  
  *Or*

- Right click on the route in the **Chart view** or the **Route List**.
- Choose **Add Waypoints** from the right mouse click menu.
- The cursor will appear with the rubber-band stretching from the last waypoint of the route.
- Click on the new location to add the new waypoint.
- To finish your route, press the right mouse button and select **Finish Route** from the menu.

*You can also end your route by selecting **Tools/Add Waypoints**. The checkmark next to **Add Waypoints** will disappear, indicating that you are no longer in route creation mode.*

**Dividing a Route**
To insert a landing in a route leg,

- Right click on the airport you want to make the new landing point.
- Choose **Land at [the selected airport]**.
- Choose the type of landing (Land Only, Land and Fill or partial fill and amount).

**Merging routes**
To combine two routes into one, i.e., eliminate a landing between two legs,

- Right click on the landing point you want removed

- Select **Don’t Land at [the selected airport]**. If you still want to use that airport as a navigation point, use any of the waypoint insertion methods to put it back in the route.

*You can also merge an entire route group by right clicking on the route group name and selecting **Merge Routes**. If you have only two legs, this is the same as using **Don’t Land**.*
Chapter 6  Flight Plan Completion

Deleting a Route or Waypoint

Route List

• Left click on a waypoint or route in the route list.
• Select Delete on your keyboard or from the right click menu.
• Click on Yes to confirm your action.

Chart View

• Click on a waypoint to highlight it.
• Right click and select Delete from the right click menu.

Working with Waypoints

“Waypoint” is a generic term for an airport, VOR, NDB, Intersection, or other navigational aid that can be used to define a route. Included are User Defined Waypoints and Route Waypoints.

Level Off and Start Descent are altitude change points, but not Waypoints. They are viewed in the profile window as a vertical red broken line or as an icon on the route in the chart view. They will not appear on the route list and can not be directly modified.

Moving User Defined Waypoints:
To reposition waypoints on the map, left click and drag the unlocked waypoint to a new location and drop it by releasing the mouse button.

Positioning a Route or User Defined Waypoint at an Exact Latitude/Longitude:

• Right click on a waypoint.
• Select Properties from the short cut menu.
• Type in an exact latitude/longitude. You can convert from decimal minutes to minutes/seconds format by entering decimal minutes in the minutes field (example: 36.45 minutes). FliteStar will automatically convert the (.45) minutes to 27 seconds and fill in the seconds field.

Delete a Waypoint

• Right click on the waypoint icon in the Chart View or on the Route List.
• Select Delete from the short cut menu.
• Click on Yes to confirm the deletion.
WAYPOINT PROPERTIES

To open the Waypoint Properties dialog:

- Select the waypoint in the Route List or in the Chart View (The waypoint will be highlighted).
- Right click and choose Properties from the right mouse click menu.

Properties for Navigational Data Objects:

An airport, nav aid or airway will display a different Properties dialog depending on the waypoint that you have selected. This information cannot be modified. See the topic Navigational Data in the online Help for additional information on Navdata Objects.

Properties for Route Waypoints and User Defined Waypoints:

A Route Waypoint or User Defined Waypoint, created either by manual routing or with the User Defined Waypoint tool, can be modified through the Properties dialog.

You may perform the following edits:

- Name or Rename the waypoint (field that you can show or hide on the Chart).
- Add Comments for the waypoint (these do not display on the Chart).

- Lock or Unlock the waypoint. To Lock a waypoint, check the Locked box in the Properties dialog. Once locked, you will not be able to inadvertently move your waypoint. You can still open the Properties dialog and move the waypoint by specifying new lat/lon coordinates. To Unlock click on the box to remove the check.

Modify Latitude, Longitude and Altitude.

Below is the properties dialog for a User Defined Waypoint. The only difference between Route and User Defined Waypoints is that the User Defined Waypoint icon can be modified by selecting a different icon from the list.
Editing User Defined Waypoints:

The User-defined Waypoints dialog in the Edit Menu lists all the user-defined waypoints you have entered. If you have not named a user-defined waypoint, it will appear in the list with its latitude and longitude.

Go to Edit/User-Defined Waypoints.

From the User Defined Waypoints dialog you can perform the following functions:

Delete a User Defined Waypoint:
- Select the waypoint from the waypoint list.
- Click on Delete.

Edit Waypoint Properties:
- Select the waypoint from the waypoint list.
- Click on Properties.

Modify the properties as described above in the section on Waypoint Properties.

Change the Default Waypoint Icon:
- Click on the Set Default Icon button.
- A list of user-defined waypoints icons will appear in the Select Default Icon dialog.
- Select the icon you wish to use as the default user-defined waypoint.
- Click OK.

The new default icon will display next to the Set Default Icon button.

Import User Defined Waypoints:

You may also import user defined waypoint files by going to File/Import/Fix user defined waypoints and following the onscreen directions.
Weight and Balance

- Go to Preflight/Weight and Balance

Or

- Click on the W&B icon in the Quick Bar.

Select your route from the drop down box at the bottom of the dialog.

The dialog displays the Center of Gravity Stations and the Center of Gravity Limits Envelope as they were set up in the aircraft model you selected for your flight. Click or use Tab to move between the boxes under the Weight heading and type in new values for each station as needed. **Note that fuel is always entered in pounds or kilograms here.**

The loading graph on the right changes to match the data as you enter it for the CG Stations, so you have an instant visual of how different weight distributions will affect flight characteristics.

The text on the bottom right of the dialog indicates “Within Envelope” or “Outside Envelope”.

Also displayed below the tables is the aircraft you have selected for this route, the Total Weight of the aircraft in pounds, Center of Gravity (in) and % MAC if applicable. Much faster than the POH and a pencil.

Weather Access

The Weather Access options in the Preflight Menu include basic functions needed to set up, import and display weather information under the Weather tab in your main view. Some of these features are also available through the Duats Controller found under the View Menu. For further details on account setup and briefing types, see DUATS Weather in the online or context-sensitive Help, or Chapter 7 of this manual.

To get a Current Weather Briefing:

- Go to View/DUATS Controller, or click on the Weather Tab. Make sure your access number and password are entered at the lower left corner of the screen.

- From the command list, double click to select the types of weather briefings and maps you want. Different types of briefings will bring up different dialogs. Select your preferences, verify your flight plan information in the dialog and click Add.

- When you have selected all the maps and briefings you want to download, click Dial in the lower left.
Chapter 6  Flight Plan Completion

To import a previously downloaded Weather Briefing:

- Go to Preflight/Weather Access/Import Briefing to open the browse dialog.
- Select the briefing you wish to work with (FliteStar names and sorts the briefings according to the date/time you retrieved them).
- Select Open to import the briefing into FliteStar.

Weather and winds aloft information from that download is now incorporated into your flight plan and available for viewing.

Reports

TRIP KITS

Once your flight plan is complete, the Trip Kit assembles and prints all the charts and reports for your flight.

- Choose the Trip Kit icon from the Quick Bar
- Or
- Select Preflight/Reports/Trip Kit.
- Select the route for which you want reports printed from the list box at the top of the dialog.
- If you want to print your reports two to a page, check Kneeboard Size (2 per page).

Vector Charts

Theme

Select the vector chart theme you want the charts printed in from the list box.
Strip Charts
You can print charts of your entire route in sequential pages, at one of five scales ranging from 1:250,000 to 1:4,000,000. The amount of paper required to print the charts will depend on the scale you choose, the length of your route and your use of the Kneeboard Option.

Departure/Stops/Destination
Prints your departure, stops along the way, and destination at a 1:25000 scale, one to a page, or two to a page using the Kneeboard option.

Entire Route
Prints your entire route on a single page.

Reports
All the reports you select here will be printed as part of the Trip Kit. See options below.

Terminal Procedures
If you have a current JeppView CD, make sure it is in your CD drive before attempting to select terminal procedures to print. Choose List... to bring up a dialog to select the terminal charts to print.

Print Preview
Review your charts and reports before printing by selecting Print Preview from the Trip Kit dialog.

THE NAVIGATION LOG
The Nav Log is set up like a standard paper log and provides basic route data, as well as specifics for each leg of your selected flight including alternate airport information.

View the Navigation Log
- Select the Reports Tab and click on the Nav Log button
  Or
  - Select Preflight/Reports/Nav Log.
## Chapter 6  Flight Plan Completion

<table>
<thead>
<tr>
<th>WAYPOINTS (FROM)</th>
<th>ROUTE</th>
<th>SEG ALT</th>
<th>WIND</th>
<th>FLIGHT</th>
<th>INST</th>
<th>SPEED</th>
<th>ETE</th>
<th>ATA</th>
<th>WIND</th>
<th>POWER</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>KAPA</strong></td>
<td>Commerial</td>
<td>5883</td>
<td>208</td>
<td>5.4</td>
<td>5.3</td>
<td>75</td>
<td>00:04:14</td>
<td>L8V</td>
<td>Climb Power</td>
<td></td>
</tr>
<tr>
<td><strong>SUN</strong></td>
<td>8721</td>
<td>208</td>
<td>468.6</td>
<td>79.3</td>
<td>75</td>
<td>00:04:14</td>
<td>L8V</td>
<td>Climb Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MJK</strong></td>
<td>13,000</td>
<td>13,000</td>
<td>147</td>
<td>469.1</td>
<td>69.3</td>
<td>75</td>
<td>00:12:12</td>
<td>L8V</td>
<td>3000/4</td>
<td></td>
</tr>
<tr>
<td><strong>PUB</strong></td>
<td>13,000</td>
<td>13,000</td>
<td>147</td>
<td>445.2</td>
<td>43.3</td>
<td>128</td>
<td>00:24:17</td>
<td>L8V</td>
<td>3000/4</td>
<td></td>
</tr>
<tr>
<td><strong>KPU</strong></td>
<td>5686</td>
<td>253</td>
<td>2.0</td>
<td>3.2</td>
<td>98</td>
<td>00:01:56</td>
<td>L8V</td>
<td>Descent Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ROUTES</strong></td>
<td>4726</td>
<td>253</td>
<td>416.6</td>
<td>0.0</td>
<td>98</td>
<td>00:48:25</td>
<td>L8V</td>
<td>Descent Power</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Route Totals:** 57.4 84.7 00:48:25
Chapter 6 Flight Plan Completion

Format Options

- Right click anywhere in the report to access the Right-Click menu.
- Set the Viewing size (Small, Medium or Large).

Choose between Standard and Expanded, and JAR-OPS forms. The expanded Nav log includes all the information in the standard Nav log as well as columns for beginning and ending altitude, wind, outside air temperature (OAT), and power settings.

Custom Options

Both the standard and expanded navigation log headings can be customized to include the following options:

- ATIS information
- Plain language route briefings
- Clearance
- V-Speed Blocks
- Power/Configuration Blocks
- Departure and arrival frequencies
- JAR-OPS Fuel Calculation
- Notes

Right mouse click on the Nav Log report and highlight Optional Blocks.

- Click on the option you want and it will be added to the report.
- To remove an item from a report, click on the option to remove the check mark next to it.

You can also use the Show All and Hide All options to add or remove optional blocks more quickly.

Header Options

To eliminate or add the solid black headers in the Nav Log, go to Tools/Options/Printing and remove or check the Use Black Headers in Printouts box.

Insert a Logo

You can include a personalized or company logo in the header of the navigation log. Right mouse click on Place Your Logo Here, then click on Set Logo Bitmap. A browse dialog appears so you can search directories to find the desired .bmp file. After you locate the file, highlight it and click on the Open button. The logo will be inserted at the top of your navigation log. Any standard bitmap (.bmp) with a minimum size of 200 by 200 pixels can be used.
Chapter 6  Flight Plan Completion

Printing the Nav Log

The Nav Log has been designed to print as a trip itinerary. To print the Nav Log, select Print from the File menu and click the OK button in the Print dialog. You can also print the report from the Route Calculator by selecting the Print Nav Log button, and in the Trip Kit.

FLIGHT PLAN FORMS

View the FAA or ICAO Flight Plan Forms

- Select the Reports Tab and click on the FAA Flight Plan or ICAO Flight Plan button.

Or

- Select Preflight/Reports/FAA Flight Plan or ICAO Flight Plan.

This opens a window containing a completed flight plan, including aircraft data from the aircraft model as well as route and aircraft performance information from the Navigation Log.

Editing the Flight Plan

The FAA and ICAO flight plans are now editable. Every single field on the reports can be changed and saved off in the route file. When you change certain fields, a warning will pop-up asking you to confirm your intentions. If you change properties of the route (such as altitude) or add a waypoint in the Chart View, those changes will be updated in the flight plan automatically, unless you have severed the connection by editing the field.

In the ICAO flight plan there is an exception to this rule. If you delete the contents of the Departure Time field of the ICAO flight plan, the field will remain blank so you can fill in the departure time later when it is known. If you want Departure Time displayed according to the route, simply use the Reset All Fields To Route option described below. The FAA report will calculate and display a time, instead of remaining blank.

Reset Fields

Once a field has been disconnected from the route, the connection can be restored by right-clicking on the field and selecting “Reset Field To Route”. All fields can be restored at once by right-clicking in the area around the report and selecting “Reset All Fields To Route”. Keep in mind that once the data is changed, it is saved off with the route and will be displayed when the route file is closed and re-loaded.

Warnings

Certain fields will not give a warning if they are edited. Changing the Type of Flight, Departure Time or Number Aboard actually changes the properties of the route, so that data is never disconnected. The warning dialog is used only when there is a potential conflict between the route and the flight plan.

Print Report

- Choose Print from the File menu
- Click the OK button in the Print dialog.
COST REPORT

The Cost Report displays calculated expenses for the planned flight according to information you entered during aircraft setup, under Edit/Aircraft Data/Operating Costs.

View the Cost Report

- Select the Reports Tab and click on the Cost Report button

Or

- Select Preflight/Reports/Cost Report.

Hourly, annual, fuel, mileage, and per flight costs are shown in the report, with the total cost for the flight displayed in the right hand column. Annual costs are allocated to the flight by dividing the Annual hours into the Annual expense, then multiplying the result by the flight time for this particular flight. Fuel cost for the flight is computed by multiplying the total fuel for the trip by the cost per fuel unit.

<table>
<thead>
<tr>
<th>COST REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>KAPA -&gt; KCGX</td>
</tr>
<tr>
<td>(Page 1 of 1)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>REPORT DATE</th>
<th>June 18, 1999</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLIGHT TIME</td>
<td>05:54:24</td>
</tr>
<tr>
<td>AIRCRAFT TYPE</td>
<td>Piper Arrow IV</td>
</tr>
<tr>
<td>AIRCRAFT TAIL #</td>
<td>N5432A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ITEM</th>
<th>HOURLY</th>
<th>ANNUAL</th>
<th>FUEL</th>
<th>MILEAGE</th>
<th>PER FLIGHT</th>
<th>COST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annual inspection</td>
<td>$700.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$20.67</td>
</tr>
<tr>
<td>Maintenance reserve</td>
<td>$500.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14.77</td>
</tr>
<tr>
<td>Avionics reserve</td>
<td>$500.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$14.77</td>
</tr>
<tr>
<td>Hangar/tiedown</td>
<td>$1500.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$44.30</td>
</tr>
<tr>
<td>Fuel</td>
<td>$25.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$147.67</td>
</tr>
<tr>
<td>Oil</td>
<td>$1.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$6.91</td>
</tr>
<tr>
<td>Oxygen refill</td>
<td></td>
<td></td>
<td>$9.00</td>
<td></td>
<td></td>
<td>$9.00</td>
</tr>
<tr>
<td>Insurance</td>
<td>$1100.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$32.49</td>
</tr>
<tr>
<td>Depreciation</td>
<td>$1500.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$44.30</td>
</tr>
</tbody>
</table>

| TOTAL | $333.88 |

Chapter 6 Flight Plan Completion
Chapter 6  Flight Plan Completion

If all the cost items are zero or otherwise strange, make sure you have entered accurate cost information in the Aircraft Data.

Print Report

• Choose Print from the File menu,
• Click the OK button in the Print dialog.

Report Options

You can use the right mouse click menu on this report to import a personal or company logo or resize the report on the screen.

WEIGHT AND BALANCE REPORT

The Weight & Balance Report depicts in graph and tabular form the loading you specified in the Preflight/Weight & Balance. The center of gravity envelope displays the weight and CG for the planned loading as well as those for landing and zero fuel conditions. Modifications you make to the Preflight W&B during flight planning will be reflected in the Report.

View the Weight and Balance Report

• Select the Reports Tab and click on the Weight & Balance button
  
  Or

• Select Preflight/Reports/Weight and Balance.

Print Report

Choose Print from the File menu

Click the OK button in the Print dialog.

Report Options

You can use the right mouse click menu on this report to import a personal or company logo or resize the report on the screen.
WEIGHT AND BALANCE MANIFEST

This feature is available in the FliteStar Corporate version only. For information on upgrading to the Corporate version, go to or call 800-621-5377 (Western Hemisphere) or +49 66102 50 8250 (Eastern hemisphere).

The Weight & Balance Manifest is written to meet FAA Part 135 requirements. The manifest displays basic route information along with weight and balance data including minimum/maximum weight, center of gravity, and mean aerodynamic chord.

View the Weight and Balance Report

- Select the **Reports** Tab and click on the **W & B Manifest** button.

Or

- Select **Preflight/Reports/Weight and Balance Manifest**.
The Manifest uses the aircraft weight and balance information from the Preflight/Weight & Balance you did earlier, and can be edited by returning to the same dialog. Aircraft data can be edited by selecting Edit/Aircraft Data and changing the desired information (See Aircraft Setup/Weight and Balance Data).

Print Report

- Choose Print from the File menu
- Click the OK button in the Print dialog.

Report Options

You can use the right mouse click menu on this report to import a personal or company logo or resize the report on the screen.

QUICK QUOTE

This feature is available in the FliteStar Corporate version only. For information on upgrading to the Corporate version, go to or call 800-621-5377 (Western Hemisphere) or +49 66102 50 8250 (Eastern hemisphere).

Quick Quote provides a quick estimate for the cost of a flight, using selected aircraft cost data.

- Select the Reports Tab and click on the Quick Quote button.

Or

- Choose Preflight/Reports/Quick Quote.
- Enter customer and flight information including aircraft tail number.
- Right click to edit the Cost data.

The itemized cost list contains aircraft expenses calculated from the aircraft cost data. If you would like to change the cost items, they can be entered in Quick Quote the same way you entered them in your aircraft data, but the new entries will not change your aircraft data. FliteStar saves cost items created in Quick Quote with your flight plan.

Right Click Menu Options

There are three right mouse click menus on Quick Quote.

- If you click without first identifying an editable field (by left clicking and highlighting the field border) a menu appears that allows you to import a company logo, size the report, set/change the tax rate, add a cost item, or reset the costs that have been modified.
Chapter 6  Flight Plan Completion

- Highlight a cost item (by left clicking on the line). A subsequent right click provides you the option to delete or modify the cost item.

- Right click in an editable non-cost item field on the report. This menu contains basic editing commands for use within that field.

Print Report

- Choose **Print** from the **File** menu

- Click the **OK** button in the **Print** dialog.